Quick Start

Project User Guide

This Quick Start Guide will show you how to create a project, as well as how to manage existing projects and how to set up your project preferences.

If you have any questions after reading this guide, click the FAQ link in the site header to see Frequently Asked Questions. If you still have questions or you experience trouble using the site, contact the OpenText help desk at 1-800-540-7292 (hours are 8am – 8pm EST Monday through Friday) or by email at support@opentext.com.

If you have any questions after reading through this guide, see the full Media Management On Demand System Administrator’s Guide. You can also.

If you have questions about the content on the site, please contact the appropriate brand administrator.

Contents
Create a Project ....................................................................................................................................... 1
Add Assets to a Project .............................................................................................................................. 3
Add Members to a Project ........................................................................................................................... 4
Annotate Assets ....................................................................................................................................... 5
Comments, Reviews, and Approvals ....................................................................................................... 10
Move a Project Asset to a Collection ....................................................................................................... 11
Check Out an Asset from a Project ......................................................................................................... 11
Check In an Asset to a Project ................................................................................................................ 12
Search for Projects .................................................................................................................................. 12
Delete Projects ......................................................................................................................................... 13
Set your User Preferences ....................................................................................................................... 13
CREATE A PROJECT
A project is a virtual workspace where you place a set of assets and collaborate with other users to develop the assets in accomplishing a project goal. The project workspace allows you to conveniently work on assets, collaborate with others, track the project’s development, and review any work completed.

An administrator can designate one of two types of projects you can create:
- A Quick Project is the fastest way to create a new project, because you only need to enter a few basic pieces of information about your project.
- An Advanced Project collects an extended set of information from you about your new project, such as contact organization, client contact, and project type, as well as optional product-related information. (This information is collectively called attributes.)

Before You Begin
Follow the appropriate procedure below, depending on whether your administrator set up your site for Quick Projects or for Advanced Projects. To determine what project type your site is set up for, click Projects in the header of any page, and then click the New Project button:
- A Quick Project appears with only a limited set of attribute fields: Project Name, Description, Start Date, and End Date.
- An Advanced Project appears with an extended set of attribute fields. In addition to the Project Name and Description, many other fields such as Department, Scope, and Contact Organization appear.

Create a Quick Project
1. Click Project in the header to see your project page. (If you have not created any projects yet, or someone else has not added you as a member to any project, no projects will appear listed on the page.)
2. Click the New Project button. The Quick Project page appears.
3. Required fields are marked with a red asterisk. These fields must be filled in. You can add or change project data at any time after the project is created.
4. Enter a name and description for your new project in the Project Name and Description fields.
5. Set a Start Date and End Date for your new project. The end date must be at least one day later than the start date. (These dates can be changed in the Timeline page as the project changes over time. See Edit a Timeline below.)
6. Click the Create button. Your new project is created, and the Project Timeline page appears.
7. Set up the Project Timeline:
   - To set Start and End dates for each phase of your new project, use the drop-down boxes. (You can add these dates later if you want. See Edit a Timeline below.)
   - To change the Active Phase (with a new project, this is the phase your project will begin with), select the radio button next to the phase you want to be active.
   - You can also set up automatic Notification so that the system sends e-mails to project members when a phase due date is approaching. For each phase, select a radio button to turn automatic notification On or Off, and for those you have turned on, enter the number of Day(s) before the due date when you want the notification to be sent out.
8. When you are finished creating the project timeline, click the Save button.

Your new project appears in your projects list. To place assets in your new project and give other users access to the project, see Add Assets to a Project and Add Members to a Project.
Create an Advanced Project

1. Click **Project** in the header to see your project page. (If you have not created any projects yet, or someone else has not added you as a member to any project, no projects will appear listed on the page.)

2. Click the **New Project** button.

3. Required fields are marked with a red asterisk. These fields must be filled in. You can add or change project data at any time after the project is created.

4. Provide information for the following fields:
   - **Project Name**: Enter a name for your new project
   - **Description**: Enter a description for your new project.
   - **Department**: Select an internal department responsible for the project.
   - **Scope**: Select a scope that reflects the geographical coverage for the project.
   - **Contact Organization**: This is the organization you belong to, as assigned by the application administrator.
   - **Client Contact**: Select a contact name for your project. This list displays individuals within your organization.
   - **Project Type**: Select a project type from the drop-down list. When you choose the project type, the screen refreshes and the project phases are automatically updated. The project type you select determines the project phases associated with your timeline. The project type cannot be edited after the project is created.
   - **Project Phase**: Select the project phase you want the project to begin with. Note: You can always return to the Timeline page later to change the active phase. You can also use the Timeline feature to change the order phases occur, by changing the start and end dates of certain phases.
   - **Start Date** and **End Date**: Set a start date and end date for your new project. The end date must be at least one day later than the start date. These dates can be changed in the Timeline page as the project changes over time.
   - **Product**: Choose a product and subproduct, if applicable, for your project.
   - **Division**: Choose a client division related to the product.
   - **Audience**: Choose an audience for the project.
   - **Status**: Use the Status area to define and regularly update your project. In the **Status** box, enter comments on the status of your project. For example, you might want to enter a weekly update noting specific tasks completed, such as an image review and approval.
   - **Keywords**: Type project keywords separated by a comma, which users can later use in a search query when searching for this project. You can search words from the other fields you have filled in (for example, you can search for projects by entering a product name or a client contact name), so enter keywords to search on for this project that do not already appear in other project information fields.
   - **Next Steps**: Use this box to regularly include notes on what is coming up next for the project. For example, you might want to enter a weekly update noting specific actions that will be completed next based on recently finished tasks, such as sending a reviewed image to the printer.
   - **Objective**: Enter a descriptive objective for your project.
   - **Approval Information**: This section reflects whether the project has achieved a pre-determined approval phase. Since this is a new project, leave the **Pending Approval** radio button selected.
   - **Job Number**: If there is a job number that applies to your project, enter it in the **Financial Information** section.

5. Click the **Create** button. Your new project is created, and the **Project Timeline** page appears.

6. Set up the **Project Timeline**:
   - To set **Start** and **End** dates for each phase of your new project, use the drop-down boxes. (You can add these dates later if you want. See **Edit a Timeline** below.)
   - To change the **Active Phase** (with a new project, this is the phase your project will begin with), select the radio button next to the phase you want to be active.
   - You can also set up automatic **Notification** so that the system sends e-mails to project members when a phase due date is approaching. For each phase, select a radio button to turn automatic notification **On** or **Off**, and for those you have turned on, enter the number of **Day(s)** before the due date when you want the notification to be sent out.
7. When you are finished creating the project timeline, click the **Save** button.

Your new project appears in your projects list. To place assets in your new project and give other users access to the project, see Add Assets to a Project and Add Members to a Project.

---

**ADD ASSETS TO A PROJECT**

There are two ways you can add assets to a project:

- **Site collection:** You can browse the site for assets. When you add an asset to a project from a collection you are not moving the actual asset, but a copy of the asset, which you can work with in every way (except checking it out to replace it with a different asset.) Once assets are added to a project from a collection, they cannot be checked out from the project because assets from collections are considered static, or unchangeable.

- **External source:** You can upload assets into a project from external sources such as your desktop or network.

Any project member with the appropriate permissions can add assets to a project. If you are in a collection and see the Projects drop-down list at the top of the collection page, you have the Download permission for that collection. If you do not have the Download permission for a collection, you must go through the ordering process for an asset to add it to a project.

**Metadata record asset, or placeholder**

You can also add a placeholder “asset” to a project. The placeholder consists solely of a metadata record. This metadata record is commonly used for situations when you want to upload an asset but the asset itself is not yet ready. You might also use this feature to have the metadata record asset represent something abstract, such as an advertising campaign or another concept that cannot be represented by a single image. Then you can link related assets to this metadata record asset. Once you have uploaded a metadata record into a project, you can check out the record, transmit it, or add comments or reviews to it just like any other asset in the project.

**Add Assets from the Site**

1. Use the Quick Search box at the top left of any page to perform a search to find the asset you want to add to your project.
2. When you find the asset you want to add to your project:
   - If you have the **Download** permission for this collection: Select the asset by clicking in the **Selection** box at the bottom right of the thumbnail image. From the **Projects** drop-down list at the top of the page select the project you want to add the asset to. To look at a project first to see if it is the right one to add the asset to, select a project and click the **View** button. When you are ready to add the asset, click the **Add** button. On the Determine Add Method pop-up page, click the **Add to Project** button. The new assets are added and the site displays your project page with the new asset.
   - If you don’t have the **Download** permission for this collection: Click the **Add to Cart** icon beneath the asset you want to add to a project. Click Cart in the header and complete the Ordering pages as appropriate. Once you have the asset saved to your computer, follow the steps below to Add the Asset from an External Source.
3. Repeat these steps to add additional assets.

**Add Assets from an External Source**

The steps for uploading assets differ slightly depending on how you have your upload preference set in My Profile.

1. Click **Project** in the header of any page.
2. Click on the **Project Name** of the project you want to add assets to. The remaining steps differ, depending on whether you have **Browser** or **Viewer** set as your upload preference on your my Profile page.

   - If you have your upload preference set to **Browser**:
     o To add a single asset to your project, click the **Browse** button at the top of the page. Navigate to the asset you want to add and double-click the asset name. The asset name appears in the **Browse** field. Click the **Upload One** button at the top of the page. The asset is loaded into your project. Some assets may take several minutes to load.
     o To add up to twenty assets to your project, click the **Upload Many** button at the top of the page. Select the number of assets you want to load, and use the **Browse** buttons to locate and select the assets you would like to load. Click the **Upload** button. The assets are loaded into your project. Some assets may take several minutes to load.

   - If you have your upload preference set to **Viewer**:
     o Click the **Upload Many** button. The Viewer Publish Wizard opens. (If the Publish Wizard does not appear, make sure you have the Viewer installed. To install the Viewer, go to My Profile and select Downloads.)
     o In the Viewer, click the **Add** button, and navigate to the assets you want to load. To remove an asset from the asset list, highlight the asset and click the **Delete** button (or the **Remove** button on the Macintosh Viewer.)
     o When you have finished adding all the assets you want to load into your project, click the **Next** button. The Publish Wizard loads your assets into your project. Some assets may take several minutes to load.

---

**ADD MEMBERS TO A PROJECT**

Only the project owner or an administrator can add members to a project. Only users who are added to a project will see the project listed in their Project page. You can assign specific permissions to members once they are added to a project.

**Add Members to a Project**

1. Click **Project** in the header of any page.
2. Click the **Project Name** of the project you want to add members to.
3. Click **Project Manager** at the top of the page.
4. Click the **Management** button.
5. Click the **Add Members** button to see the list of users you have permission to add to this project.
6. Click the name of the **Organization [o]** or **User [u]** you want to add to this project. To select multiple names, hold down your **Ctrl** key while clicking on the names.
7. Click the **Add Members** button.

The members are added to your project, can view assets within the project, and will receive an automatic notification of their inclusion in the project. See **Assign Member Permissions for a Project**, below, to assign additional permissions to specific project members, including assigning the right to approve a project.

**Assign Member Permissions for a Project**

A project owner or administrator can assign individual member permissions for a project. Unless permissions are explicitly assigned, members added to a project only have permission to view the assets within the project.

**Table of Project Permissions**

<table>
<thead>
<tr>
<th>To permit a user to perform this action</th>
<th>. . . assign this permission:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add assets to the project</td>
<td><strong>Add</strong></td>
</tr>
<tr>
<td>Remove assets from the project, and delete the entire project</td>
<td><strong>Remove</strong></td>
</tr>
</tbody>
</table>
Quick Start: Project User Guide

Annotate project assets with the Viewer
Annotate

Check out project assets to replace them with new assets
Checkout

Move assets from the project into a collection, to be stored and available for searching by other users
Publish

Make changes to the project mission and timeline, and approve the project when it reaches a pre-designated phase
Edit

Mark an asset in the project as “approved” or “rejected” on the asset’s Details page
Approve

1. Click Project in the header of any page.
2. Click the Project Name of the project you want to set permissions for.
3. Click Project Manager at the top of the page.
4. Click the Management button.
5. Click on the name of the user you want to set individual permissions for. To select multiple names, hold down your Ctrl key while clicking on the names.
6. Click the Modify Permissions button. An asterisk * appears next to permissions that are already granted to a user based on their organization or user category.
7. Click to put a checkmark in the box below each permission you want to grant the user listed on the left-hand side. The table above shows you what actions each permission allows.
   • If you assign a member the Publish permission, which allows them to publish assets to a collection, remember to also assign that member permission to add assets to a collection (or collections) using the Collection Manager. The administrator may need to do this.
   • If you want project approval to occur, remember to assign a specific individual the right to grant project approval at the completion of a pre-designated phase.
8. When you are finished selecting permissions, click the Save & Exit button. The project permissions you selected are granted to the member(s) you assigned them to.

ANNOorate ASSETS

You must have the Viewer installed on your computer, and the Annotate permission assigned to you for a project, before you can use the annotation tools. To download the Viewer, go to My Profile, then select Downloads. Once the Viewer is installed on your machine, double-click the Viewer icon on your desktop to set up the Viewer. See your administrator or project manager for permission to annotate assets.

Draw with the Freehand Tool

The freehand tool lets you draw on assets, like a pen drawing directly on a photograph or document.

1. In a project, click the Add Annotation icon beneath any asset. The Viewer opens, with the asset opened inside.
2. For videos, click the Play button on the Viewer. When you see the frame you want to draw on, click the Pause button on the Viewer. You can also navigate with the Previous Frame and Next Frame buttons.
3. Click the Freehand tool. Your mouse pointer becomes a pencil. Draw on the image.
4. Edit your annotation as you wish. You can select Undo from the Edit menu if you don’t like your most recent change:
   • To adjust color and width of lines, click the Select tool, and click on your annotation to select it. Click Edit, select Color or Width, and edit your freehand annotation.
   • To move an annotation, click the Select tool. Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow, and then click on the annotation. Hold down the left mouse button while you drag the object to another location.

© 2012 Media Management On Demand 5
a video asset, you can move an annotation to another place in the same frame, but not to a different frame.

- To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.

5. For videos, to add an annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button.

6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.

7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

---

### Add Visual Notes with the Sticky Note Tool

The sticky notes tool lets you paste a “sticky note” onto an image and then type text onto the “note.”

1. In a project, click the **Add Annotation** icon beneath any asset. The Viewer opens, with the asset opened inside.

2. For videos, click the **Play** button on the Viewer. When you see the frame you want to add a note to, click the **Pause** button on the Viewer. You can also navigate with the **Previous Frame** and **Next Frame** buttons.

3. Click the **Sticky Notes** tool. Your mouse pointer becomes a sticky note. Click on the area of the image where you want to add the note, and type text in the note.

4. Edit your annotation as you wish. You can select **Undo** from the **Edit** menu if you don’t like your most recent change:
   - To edit the font of your text or the background color of the note, click **Edit**, select **Font** or **Color**, and make your changes.
   - To resize the note, select the note, click on one of the tiny boxes on the note’s outline, hold down your left mouse button, and drag the edge outward or inward.
   - To edit the text, double-click on the text to select it. You can type over the selected text, you can press **Ctrl+x** to cut the text out, you can press **Ctrl+c** to copy the text, and you can press **Ctrl+v** to paste the text in another note.
   - To move an annotation, click the **Select** tool. Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow, and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
   - To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.

5. For videos, to add an annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button.

6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.

7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

---

### Add Text with the Text Tool

The text tool lets you type text comments directly on an image.

1. In a project, click the **Add Annotation** icon beneath any asset. The Viewer opens, with the asset opened inside.

2. For videos, click the **Play** button on the Viewer. When you see the frame you want to add text to, click the **Pause** button on the Viewer. You can also navigate with the **Previous Frame** and **Next Frame** buttons.

3. Click the **Text** tool, and then click on the asset where you want to add text. Enter your text in the text box.

4. Edit your annotation as you wish. You can select **Undo** from the **Edit** menu if you don’t like your most recent change:
Quick Start: Project User Guide

• To edit the text font color, type, size and so forth, select your annotation, click **Edit**, select **Font** and make your changes.
• To resize the note, select the note, click on one of the tiny boxes on the note’s outline, hold down your left mouse button, and drag the edge outward or inward.
• To edit the text, double-click on the text to select it. You can type over the selected text, you can press **Ctrl+x** to cut the text out, you can press **Ctrl+c** to copy the text, and you can press **Ctrl+v** to paste the text in another note.
• To move an annotation, click the **Select** tool. Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow, and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
• To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.

5. For videos, to add an annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button.
6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

**Add Audio Notes with the Sound Note Tool**

With the audio note tool, you can add a recorded audio message to a video asset if you have a microphone and Microsoft DirectX loaded on your computer.

1. In a project, click the **Add Annotation** icon beneath any asset. The Viewer opens, with the asset opened inside.
2. Click the **Play** button on the Viewer. When you see the frame you want to add a note to, click the **Pause** button on the Viewer. You can also navigate with the **Previous Frame** and **Next Frame** buttons.
3. Click the **Audio Notes** tool, and then double-click on the frame where you want to add the audio note. The **Sound Annotation** window opens.
4. Click the red **Record** button, and record your message. You can preview your message in the **review** area of the **Sound Annotation** window, and re-record your message if you wish.
5. Click the **OK** button when you are finished. An audio annotation icon appears on the asset frame, which plays your message when you click on it.
• To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.
• To add an annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button.
6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

**Add a Rectangle/Square with the Rectangle Tool**

The rectangle tool instantly places a geometric shape on an image, and you can size it by dragging.

1. In a project, click the **Add Annotation** icon beneath any asset. The Viewer opens, with the asset opened inside.
2. For videos, click the **Play** button on the Viewer. When you see the frame you want to add a rectangle to, click the **Pause** button on the Viewer. You can also navigate with the **Previous Frame** and **Next Frame** buttons.
3. Click the **Rectangle** tool. Click on the image where you want to place the annotation, hold down your left mouse button, and drag outward.
4. Edit your annotation as you wish. You can select **Undo** from the **Edit** menu if you don’t like your most recent change:
   - To resize the shape, select the shape, click on one of the tiny boxes on the shape’s outline, hold down your left mouse button, and drag the edge outward or inward.
   - To adjust color and width of lines, select your annotation. Click **Edit**, select **Color** or **Width**, and edit your annotation.
   - To move an annotation, click the **Select** tool . Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow , and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
   - To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.
5. For videos, to add another annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button .
6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

**Add a Circle/Oval with the Circle Tool**

The circle tool instantly places a circular geometric shape on an image, and you can size it by dragging.

1. In a project, click the **Add Annotation** icon beneath any asset. The Viewer opens, with the asset opened inside.
2. For videos, click the **Play** button on the Viewer. When you see the frame you want to add a circle to, click the **Pause** button on the Viewer. You can also navigate with the **Previous Frame** and **Next Frame** buttons .
3. Click the **Circle** tool. Click on the image where you want to place the annotation, hold down your left mouse button, and drag outward.
4. Edit your annotation as you wish. You can select **Undo** from the **Edit** menu if you don’t like your most recent change:
   - To resize the shape, select the shape, click on one of the tiny boxes on the shape’s outline, hold down your left mouse button, and drag the edge outward or inward.
   - To adjust color and width of lines, select your annotation. Click **Edit**, select **Color** or **Width**, and edit your annotation.
   - To move an annotation, click the **Select** tool . Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow , and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
   - To delete the annotation, select the annotation, click **Edit**, and select **Delete**. The annotation is deleted.
5. For videos, to add another annotation to another video frame click the **Play** button and then the **Pause** button. Otherwise, click the **Stop** button .
6. **Caution**: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the **File** menu, select **Upload**. Your annotations are added to the asset’s Review History.

**Add an Arrow with the Arrow Tool**

The arrow tool instantly places an arrow on an image, which you can size and direct by dragging.
1. In a project, click the Add Annotation icon beneath any asset. The Viewer opens, with the asset opened inside.
2. For videos, click the Play button on the Viewer. When you see the frame you want to add an arrow to, click the Pause button on the Viewer. You can also navigate with the Previous Frame and Next Frame buttons.
3. Click the Arrow tool. Click on the image where you want to place the annotation, and hold down your mouse button and drag in the direction you want the arrow to point.
4. Edit your annotation as you wish. You can select Undo from the Edit menu if you don’t like your most recent change:
   - To change the arrow’s length or point it in a different direction, select the arrow, click on one of the tiny boxes at either end of the arrow, hold down your left mouse button, and drag the arrow.
   - To edit the arrow’s color or width, click Edit, select Color or Width, and edit your annotation.
   - To move an annotation, click the Select tool. Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow, and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
   - To delete the annotation, select the annotation, click Edit, and select Delete. The annotation is deleted.
5. For videos, to add another annotation to another video frame click the Play button and then the Pause button. Otherwise, click the Stop button.
6. Caution: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the File menu, select Upload. Your annotations are added to the asset’s Review History.

Add an Instant Comment with the Rubber Stamp Tool

The rubber stamp tool instantly places a comment on an image. Use the rubber stamp tool for common comments you frequently use in annotations. You can easily customize rubber stamps.

1. In a project, click the Add Annotation icon beneath any asset. The Viewer opens, with the asset opened inside.
2. For videos, click the Play button on the Viewer. When you see the frame you want to add text to, click the Pause button on the Viewer. You can also navigate with the Previous Frame and Next Frame buttons.
3. Click the Rubber Stamp tool and select one of the available stamp comments from the drop-down list. Click on the image where you want to place the stamp.
   - To create a new stamp comment, select Edit, select Preferences, and click the Tools tab. Type your own text in the Stamp 1, Stamp 2, or Stamp 3 fields, and click the OK button.
4. Editing a rubber stamp involves deleting the existing stamp annotation and creating a new rubber stamp that reflects your desired changes:
   - Delete the existing annotation by selecting the annotation, clicking Edit, and selecting Delete. The annotation is deleted.
   - Create a new stamp by clicking Edit, selecting Preferences, and clicking the Tools tab. Enter the text you want in one of the Stamp fields, and click the OK button. Click the Stamp tool, select your new stamp and click on the image where you want to place the stamp.
   - To change the font type, size, color and so forth, select your annotation, click Edit and select Font. Make your changes and click the OK button.
   - To move an annotation, click the Select tool. Place the mouse cursor over the annotation you want to move until the cursor changes to a four-way arrow, and then click on the annotation. Hold down the left mouse button while you drag the object to another location. In a video asset, you can move an annotation to another place in the same frame, but not to a different frame.
5. For videos, to add another annotation to another video frame click the Play button and then the Pause button. Otherwise, click the Stop button.
6. Caution: Before you upload, make sure you have finished editing your annotation(s). Once you upload the asset with its annotations, you cannot edit, move, or delete annotations.
7. When you are finished annotating the asset, from the File menu, select Upload. Your annotations are added to the asset’s Review History.

COMMENTS, REVIEWS, AND APPROVALS

Project and asset reviews and approvals occur on two levels:

- On a higher level, an entire project can be approved when it reaches a certain phase, by a user with the appropriate permission. This approval cannot be reversed. Note: You cannot approve a project created as a Quick Project.
- On a detailed level, each asset within a project can be reviewed, commented on, annotated, approved, or rejected individually by any user with permission to do so.

A review of a project’s assets is an opportunity to comment generally on the individual assets that are gathered and developed for a project, and to approve or reject those assets. Reviewers can also add annotations to an asset as part of their review. All comments, annotations, approvals, and rejections appear in each asset’s Review History.

The Review History is a place for everyone in the project group to communicate about an asset during project development. Review comments are date-stamped, and the reviewer’s name appears next to them. Approvals and rejections are also name- and date-stamped.

Approve a Project

Project approval is a simple way to have a project reflect whether it has reached a pre-designated phase, at which point it is considered “approved.” For example, a small group of users may wish to work exclusively on a project to get it started. Once it has reached a phase where additional users can be brought in to continue the work, the project can be marked as Approved so that it is clear the project has moved from the smaller group to a wider audience.

Note: You cannot approve a project that was created as a Quick Project. (A description of Advanced Projects and Quick Projects is at the beginning of this guide.)

1. Click Projects at the top of any page. Click on the Project Name of the project you want to approve. For help locating a project, see Search for Projects above.
2. Click Project Manager, and select the Mission button.
3. Under the Approval Information area, select the Approved radio button to change the Approval Status.
4. Click the Save button. If you want to open your project to a wider set of users at this point, see Add Users to a Project, above.

Comment on, Approve, or Reject an Asset

When you review an asset in a project, you write a comment about it. You can also add an annotation to the asset if you want, to place your review comments on an image or video exactly where they pertain.

When you approve or reject an asset, the asset’s Review History shows either “Approved” or “Rejected.”

1. Click Projects at the top of any page. Click on the Project Name of the project that holds the asset(s) you want to review, approve, or reject. For help locating a project, see Search for Projects above.
2. Click the Add Review icon at the bottom of the asset you want to review.
• To make comments, enter text in the Comments box and click the Add Review button. Your comment appears in the Review History for this asset, with your name and the date recorded.
• To add an annotation to the asset to illustrate your comments, click the Annotate icon. See Annotation Assets for more information about annotating.
• To approve or reject an asset, click either the Approve button or the Reject button. Your name and Approval or Rejection appear in the asset’s Review History.

MOVE A PROJECT ASSET TO A COLLECTION
When you are finished working with an asset in a project, you can publish the asset to a collection in the site. A collection is a group of stored assets. By publishing a project asset to a collection, you store the asset and make it available to anyone who has access to that collection. Before you publish, consider the following restrictions:

• Once an asset is published to a collection, it can no longer be checked out from the project area for replacement. (Assets in collections are considered static, or unchangeable.)
• If an asset was originally added into the project from a collection, that asset cannot be published back into a collection. Note the exception in the next bullet.
• If an asset was checked out to a project from a collection, it must be checked back into the collection when you are finished working on the asset.
• If the collection assets are watermarked, the asset you publish from a project will not be watermarked; watermarking can only be applied when assets are originally loaded into a collection.

If an asset has an associated set of annotations (called an annotation history) that were completed during the project, those from the most recent version of the asset will also be published to the collection (as read-only) along with the asset.

You must have permission to publish a project asset to a collection, and you must also have permission assigned by the administrator to add assets to a collection or collections.

1. Click Projects at the top of any page. Click on the Project Name of the project that has the asset(s) you want to publish. For help locating a project, see Search for Projects above.
2. Click to put a check mark inside the Selection box beneath the asset(s) you want to publish.
   • All assets you select will be published to the same collection.
   • You cannot publish an asset that is currently checked out.
3. Click the Add to Collection icon.
   • If the asset was originally checked out from a collection to the project, the Check in from Project page appears. Click the Check In button and the asset is automatically checked back into the collection it was originally checked out from, and you are finished with this procedure.
4. From the Add to drop-down list, select a collection to publish your asset(s) to, and click the Add button. The Captioning page appears.
5. Fill in the captioning information for your asset.
6. When you are finished captioning, your asset is published to the collection. The asset remains in the project as well, so you can complete further work with it if desired, but the Checkout button beneath the asset’s thumbnail image is now disabled as it is with all project assets that are moved to a collection.

CHECK OUT AN ASSET FROM A PROJECT
You can check out any asset from a project, as long as that asset was not added to the project from a collection or is not already checked out. If the check out icon is grayed out (if it appears a darker gray
than the icons around it), the asset is already checked out; you can click on the grayed out icon to see who has checked out the asset.

1. Click Projects at the top of any page. Click on the Project Name of the project from which you want to check an asset out. For help locating a project, see Search for Projects above.
2. Click the Check Out icon beneath the asset you want to check out.
3. In the Check Out page, you may enter a Note for the asset version tracking log (which is accessible through the database by the administrator.) Click the Check-out button. The asset is checked out and, if you wrote a note, the version log is updated.

When the new image is ready for check-in, or you want to undo the asset checkout, follow the Check In an Asset procedure below.

---

CHECK IN AN ASSET TO A PROJECT

You use the checkout/in feature in the site when you want to replace an existing project asset with a new asset. The site records any newly checked-in assets as versions of the first asset, so you can keep track of your asset editing process. You can also use the check in feature to simply undo an asset check out if you want to restore the checked-out image.

1. Click Projects at the top of any page. Click on the Project Name of the project that you want to check an asset in to. For help locating a project, see Search for Projects above.
2. Under the thumbnail image of the asset you want to check in, click the Check In icon.
3. To undo the check out and restore the old asset version, click the Undo Check Out button. The old asset is restored.
4. To check in a new version of the asset, click the Browse button to locate the new image, and click the Continue button. The new asset replaces the old asset in your project. You can see the old asset by viewing the asset’s version history.

---

SEARCH FOR PROJECTS

You can locate a project by:

- Clicking on Project in the header of any page and scrolling or navigating through your projects list to find a project.
- Following the procedure below to submit a search query, which involves selecting data fields or by entering keywords in the project search fields. Searches include all projects you have permission to access. From the search results, you can click on a project name and the project opens for you. Searching projects in this way can be a useful reporting feature for viewing a list of projects that all share specific attributes.

**Search for a project**

1. Click Projects at the top of any page. Click the Search Projects button at the top right of your page. The Search Projects page appears.
2. Enter search terms:
   - **Attributes (field) search:** You can enter a search term in any field, or select any option from a drop-down list or set of radio buttons.
   - **Keyword search:** If you don’t know enough specific data about a project to choose from the attributes (field) options, you can search for projects using general keywords in the Keywords box under the Status area. Enter keywords that relate to the project you want. Enter any keyword that might have been used to describe the project when it was created.
   - **Note:** **Combining search terms:** If you fill in more than one field to be searched on, or you type more than one word to be searched for in a single field, the site looks for all the words or selections you have entered to find a match. (Another way to understand this is to imagine
Quick Start: Project User Guide

an invisible AND between all your search terms.) So if you enter several search terms and do not get any results back, try removing most of them and searching with only one or two of your most likely search terms.

3. Click the **Search** button at the bottom of the page. The site returns a search results page with a list of projects that match the search criteria you selected. To retry your search, click the **Search Projects** button from your search results page and enter new search criteria. The site searches on all projects you have access to, not just the projects listed on the search results page.

### DELETE PROJECTS

When a project is deleted, all the assets associated with that project are also deleted. In addition, any subprojects that were created within that project are also deleted. Only a project member with the appropriate permissions can delete a project.

**Delete a project**

1. Click **Projects** at the top of any page.
2. Click to put a checkmark in the checkbox next to the project you want to delete, and click the **Delete** icon 🗑. Your project is deleted.

If you need to recover a deleted project, the site administrator can do this for you.

### SET YOUR USER PREFERENCES

You can set up your Project pages to display the project data and project search results as you wish to see them.

**Set project display preferences**

1. Click **My Profile** in the header of any page.
2. Click the **Set Your Preferences** link. The **Preferences** page appears.
3. You can define how your projects are listed on your Project page. In the Current Project Preferences area, select a project attribute to appear for each of the four **Columns** in the list that is displayed on your Project page. (The project name will always appear as the first column in the list.)
   
   For example, when looking at your list of projects you might prefer to see the project End Date column next to the project name, the Metrics of Success column displayed third, and the Contact User Name column displayed fourth. Or if Project Type is more important to you than dates or contacts, you can select that information to appear as a column.

4. You can sort your projects based on any of the columns you chose in the step above. Decide on one column to serve as the default column to sort your list of projects by on your Project page, and click a **Sort by** radio button next to your chosen column.

5. Select whether you want the Sort by column to sort itself in ascending (**Asc**) or descending (**Desc**) order. Ascending order for words is alphabetical order, and for numbers it is numerical order. Descending order for words is reverse-alphabetical order, and for numbers it is reverse-numerical order.

6. Click the **Update** button. You can come back to change your preferences at any time.

**Set project search results preferences**

You can limit the number of assets you see each time you open a project, and you can choose how you want your assets displayed within a project.

1. Click **My Profile** in the header of any page.
2. Click the **Set Your Preferences** link. The **Preferences** page appears.
3. In the Layout Preferences area, under **Collaborate Default View**, select the number of assets you want to appear when you open a project.

4. Next to Collaborate Default View, select how you want your assets displayed:
   - **Images**: Displays only thumbnail images for project assets.
   - **Images & Text**: Displays thumbnail images plus asset review history and annotation links for project assets.

5. Click the **Update** button. You can come back to change your preferences at any time.